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1 Overview 
 
1.1 Document History 

 

Date Writer Main Points 
2019-05-22 Yoontae Hwang Writing a draft 

 
1.2 Explanation of abbreviations and terms 

Track The unit in which the radar counts an object (vehicle). 

Tracking The term ‘tracking’ is used when the recognition is made by the radar. 

Hotspot Zone The lane that is given with extra attention when recognition process is            
conducted with radar 

 
1.3 Legal Notice 
This document is subject to change without notice, and the information contained herein is 
attributed to Bitsensing's proprietary property. 
 
Bitsensing shall not be held responsible for any errors, inaccuracies or imperfections contained 
in this manual or other disclosures relating to the manual. This manual is designed for general 
use and it may not be appropriate to use the manual for the special circumstances. 
 
The PC environment and the surrounding environment of the radar may differ by different 
users that Bitsensing is not eligible to provide any sort of warranty regarding information and 
the test procedure. In other words, the manual is designed to provide the user with installation 
guidance information only. It is user’s responsibility to check the compatibility of user’s purpose 
against the product specifications and purpose. If there is uncertainty in employing the radar 
due to the usage in the special case, the user is advised to consult with the appropriate expert 
before the installation. 

 
 



 

 

2 Installing and Setting up programs 
 
2.1 Program Installation 
Explanation: Program Installation (Before moving onto the use of Radar Analyzer)  
 
1. (a) Open ‘file BTS_Setup.exe’ 

(b) Select the location where you want to create the Radar Analyzer program 
2. (a) Modify the name of the program you want to download  

(b) Select the location where you want to create the shortcut file.  
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Choose whether to create a shortcut file on your desktop. 

4. Download and complete files 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
  



 

 

2.2 Program Configuration 
When you run Radar Analyzer, the following basic screen appears: The screen consists of two 
rows of menu bars at the top and eight windows. In this chapter, the description for each 
component will be given, and setting up of the Radar Analyzer will be discussed in the following 
chapter. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1. Menu 

All the functions with Radar Analyzer can be manipulated on the menu. All the data 
measured by radar can be designated to be recorded and recalled, where the records can 
be started and/or stopped. 

 
 
 
 
 
2. Device List 

It consists of a list of various sensors used through the Radar Analyzer. In addition, details 
of the sensors can be modified.  

 
 
 
 
 
 
 
 
 
 
3. Properties 

This section helps the user to (a) correct the inevitable errors of the radar and (b) 



 

 

manipulate the optional settings to make it easier for the users to handle radar, video 
display, and data window. The settings conducted at this phase will influence the 
visualization of the data. Thus, appropriate setting is important for the facile usage of Radar 
Analyzer. 
 

 

 
 
4. Radar 

Based on data measured by Radar, the moving vehicle is recognized as a single track where 
the movement of the vehicle is made within the lane. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  



 

 

5. GPS 
Provision of the installed location once the Radar is connected with the network. 

 
 
 
 
 
 
 
 

 
 
 

6. Images 
Images taken with a built-in front camera are sent in real-time. The vehicles that are being 
tracked will have the different color tags depending on the speed information (Note. the 
color setting can be changed in the Properties window) 

 
7. Data 

Shows data such as the location, velocity, and so on for an object measured by Radar. 
 
 
 
 
 

 
 

8. Output 
It outputs connection status and availability of external devices such as Radars and 
cameras. 
 
 
 
 
 
 
 
 
 
 

9. Error List 
Outputs errors that occur during use of the Radar Analyzer. 

 
  



 

 

2.3 Program Settings 
Before the collection of data through radar, it will be helpful to have a depth understanding of 
the settings of the aforementioned components to handle Radar Analyzer with an ease. 
 
1. Delete, and create layouts 

Radar Analyzer offers various services such as displaying data measured through radar and 
images driven by the front-camera, and location information through GPS. The spectrum of 
services required by each and every user will be different, and it is possible to delete under-
utilized windows and customize the services according to different users. The Icon ‘X’ on the 
upper right corner of (a) error list, (b) output, and (c) property window can be used for the 
deletion of the services (Note. the recreation of the service can be conducted using ‘View 
tab’ at the top). 
 
 
 
 
 
 
 
 
 
 
 

2. Change layout size and location 
If you are using Radar Analyzer, you may want to check the vehicles tracked by radar more 
precisely or to view the images of the front camera in more detail. In case of this situation, 
Radar Analyzer is designed to allow you to change the size of the window. To change the 
size of a window, you can change the size as much as you want by placing the mouse on 
the edge of the window and dragging it when an arrow occurs. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

 

Other customization can be made to fit user’s needs. The repositioning & resizing of the 
layout is possible by simply dragging the required windows to the required position. 
 
 
 
 
 
 
 
 
 
 
 
 

3. Layout Floating and Docking 
The window that is intriguing according to the user can be separated from the layout and 
viewed independently to provide more effectiveness. Floating is the function that separates 
the selected windows from the layout. The below example depicts the Floating Function 
where Properties window is detached from the layout (Note. Floating and Docking are the 
terms that need to be understood for the separation, where Docking is only performed after 
the Floating). 

 
 
 
 
 
 
 
 
 
 
 
The docking function, as opposed to floating functions, is a function that moves the slotted 
window back to the layout. The use of Docking Function will return the separated windows 
back to the layout. 
 
 
 
 
 
 
 
 
 

 



 

 

4. Save and Manage Layouts 
It is extremely cumbersome and inefficient to reset a layout created by the previous process 
each time you run the Radar Analyzer. To prevent users from experiencing this cumbersome 
process, Radar Analyzer is providing the ability to store, retrieve and manage set-up layouts. 
First, let me explain about the storage function. Clicking on the window tab in the top menu 
bar will bring up the list as shown in the bottom left, and clicking Save Window Layout will 
open the window in the lower right corner. When you create a name for the set layout and 
click OK, the current layout is saved. 
 
 
 
 
 
 
 
 
 
 
 
If so, you might be wondering what to do to bring in and use the saved layout. Clicking on 
the window tab will bring up a list of the layouts you've created so far by placing your 
mouse over 'Apply Window Layout'. Click on any of the listed layouts to set them up. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If you have saved layouts that are not used and need to be deleted, click Manage Window 
Layouts on the window tab to see all the saved layouts. You can delete the layout by 
selecting one that is not in use. You can also change your name. 
 



 

 

 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
If you want to use the layouts provided by Radar Analyzer by default, simply click 'Reset 
Window Layout' and click 'Yes' in the new window that exits. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
  



 

 

3 Data Recording using Radar Analyzer 
Radar Analyzer stores the speed, acceleration, ID and distance of the vehicle measured by the 
radar in a record file within the Radar Analyzer file. This stored data is called Logging Data and 
logging data can be replayed using the Radar Analyzer. 
 
3.1 Creating and Managing files 
Let me explain how to create and manage a file for storing data measured by radar. 
 
1. Creating a file 

(a) Press ‘New’ on the top-line file tab of the top menu bar 
(b) Press ‘Icon’ at the further left of the bottom of the menu bar 
Both methods can open a new record window and create new files.  
Once the file is opened and is saved, the file will be saved as BTS/Rec/Record Pat. 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 

 
The data can be stored by using ‘record start’ function (note. detailed manual will be 
provided for the record start function). It is to note that the saved data cannot be adjusted 
with the current s/w version that the stoppage of the recording must be handled cautiously. 

 
3.2 Recording and Checking 
Since the radar and the PC are well connected and the data measurement setup is complete, 
we will measure and record the data using the radar and check it out. 
 
1. Recording 

To record data measured by the radar, ‘Start Recording’ must be selected (where it is found 
in sub-list of the Record on the top menu, or Start Recording Icon at the bottom line). Once 
the function is activated, the data obtained from the radar and images from the front-
camera will be displayed. 
 
 
 



 

 

 
 
 
 
 
 
 
 
 
 
To stop or end recording, press ‘Stop Recording (where it is found in sub-list of the record 
on the top menu, or Stop Recording Icon at the bottom line). When this function is 
performed, all the functions including data measurement by radar and images taken by the 
front-camera are stopped. 

 
 
 
 
 
 
  
 
 
 
 
 
2. Checking the record 

To retrieve a file that previously saved the record, you can use the "Open" button on the 
File tab at the top of the menu bar or the "Open" icon at the bottom of the menu bar. By 
default, the file is stored in the Record folder and can be loaded (*.rec). 
 

 
 

 
 
 
 

 
 
 
 
 
 
 
 



 

 

3.3 Equipment Management 
Before measuring data with radar, make sure that the radar is in a measurable condition and 
that the radar is well connected to the PC. 
 
1. Add Device 

If the radar and the PC are well connected, the radar can be added to the equipment list so 
that data can be received. The device can be added through ‘Add Equipement’ Function 
(found in Recording tab of the menu bar or the Add Device icon on the bottom of the menu 
bar). 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

The preceding activities will result in an Add/Modify Device window. In addition, GPS, front-
cameras and radar can be connected in this window.  
 
 
 

 
 
 
 
 
 
 
 
  

 
2. Device Settings 

In order to use the radar efficiently, the following properties window should be used. The 
three tabs in the Properties window allow you to set up the visual parts of the radar and the 
visual window. Setup line and Setup Track establishes the way radar window is displayed. 

 
 



 

 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The radar window functions to show the movements of objects detected by the radar on a 
randomly set lane. At this point, the radar window can be modified using a property window 
to more effectively check the movements of objects. For example, a radar window, by 
default, has four lanes, and if the radar is located on a two-lane road, it should be able to 
change the drawing so that only two lanes are drawn. Setting up the visual effects of these 
radar windows is the function of the Setup Lane tab. The Setup Track also has the ability to 
set the visual effects of the tracked vehicle in the radar window. 
 
<Setup Lane> 
①  Display Range 
The Display Range, which controls the length and width of the lane in the radar window. 
 
② Starting Point 
The starting point can change the coordinates of the lane in the radar window. 
 
③ The number of Lanes 
The number of Lanes is an item that controls the number of lanes drawn in the radar 
window. 
 
④ Lane Axis 
Lane Axis is the section to modify the direction of the radar if it does not have same 
direction to that of the lanes. 
 
⑤ Display Speed 
Display Speed limits the speed so that objects that are not within the speed range are not 



 

 

shown in the radar window. 
 
⑥ Installation Height 
Radar measures the data assuming that it is at the same height as the object it detects. In 
general, however, the radar is installed about 8 meters above the ground, resulting in 
errors. Errors due to the installed position of these radars can be corrected using the 
Installation Height item. 
 
⑦ Auto Calibration 
After radar is installed, it can be tilted for several reasons. In the event of such an error, it is 
possible to correct the tilt with the Auto Calibration item.  
 
⑧ Tracking Zone View 
Tracking Zone View is used with items on the hotspot zone at the bottom. The hotspot zone 
items have items that modify the length of the hotspot zone and items called HZ 
Width/Center for visual implementation. In addition, the area where the vehicle is to be 
tracked can be set through the tracking zone, which is not visible from the radar window 
even if the radar detects the vehicle when the vehicle passes the tracking zone. If you check 
the Tracking Zone View after you have set up all of the tracking zones, the settings for the 
tracking zone are also reflected. In other words, if the Tracking Zone View is not checked 
even when the tracking zone is set, its contents are not reflected. At the bottom is an item 
called Horizontal Line, which functions as drawing a horizontal line to make the distance 
clearer. 
 
<Setup Track> 
① Width와 Length  
Width and Length can adjust the size of the rectangle that implements the tracked vehicle. 
 
②  Show Track 
You must check Show Track to create a rectangle that implements the tracked vehicle.  
 
③  View Speed 
With View Speed, the vehicle's speed is derived from a rectangle. And the decimal places of 
speed can also be set.  
 
④  View ID 
You can use the View ID to identify the vehicle. This makes it easier to identify the 
information of the vehicle to be identified. 
 
If all settings are finished using the Properties pane, you should reflect these settings using 
the Accept button just below the Properties pane. And if you want to go back to the settings 
that are basically implemented, you can use the Default button. 
 



 

 

 
 

 
 
 
 

Once the setup has been completed to use the equipment, the radar should be connected to 
the Radar Analyzer. The main reason for using the Radar Analyzer is to simultaneously 
check the images taken from the camera. Therefore, the camera must be connected. To 
connect the camera to the Radar Analyzer, you can run the preview function on the Run tab 
at the top of the menu bar or the preview icon at the bottom of the menu bar. When 
executed, a camera connection window opens, which enters the password, and the 
password is ‘default’. Press the OK button to connect the camera. 
 
 
 
 
 
 
 

  



 

 

4 Improvements 
 
Radar Analyzer is a draft of the manual for use, so there may be insufficient or 
missing explanations. In addition, there are features that are not yet implemented or 
that are insufficient because the Radar Analyzer is designed to meet the needs of 
users of various purposes. Therefore, we would prefer to inform users of the 
improvements they perceive so that they do not experience inconvenience in using 
Radar Analyzer. 
 
1. Add Help Tab Features 

For the Help tab on the far right side of the menu bar, there are many features that are not 
yet supported Help will also be provided based on manual documentation to make it easier 
for users to use Radar Analyzer. The product code will allow users to manage the service 
and update the program online. Support features will be implemented in the shortest 
possible time so that users won't have difficulty using the Radar Analyzer. 

 
2. Specify shortcuts 

Other features do not yet have shortcuts, except for the settings on the File tab and the 
equipment list on the View tab. More shortcuts will be designated to make it more 
convenient for users. 
 

3. Floating and Docking function 
In the list of window tabs, there is a function called floating and docking. Running a floating 
function with a window selected can remove the window from its layout, but it may be 
inconvenient to use it, depending on your PC, by going up to the screen. Floating functions 
can be disabled through the docking function, but will be modified to make it easier for 
users to use them because the floating features they really wanted to implement are not 
implemented properly. 
 

4. Save Icon error 
Occasionally, clicking the Save icon results in an error that causes the program to shut down 
automatically The obvious reasons are currently under control, but if this error occurs, we 
recommend shutting down and restarting your PC or using the File tab. 

 
If you find any improvements you have found in your use, please contact us on the next page 
and we will make changes. 

  



 

 

5 Contact 
For additional questions or technical support, please contact Bitsensing at: 
 
Address: 
165, Yeoksam-ro, Gangnam-gu, Seoul 06247, Republic of Korea 
 
Office Number / Fax Number: 
 
Office Number: +82.70.7114.1010 
Fax Number: +82.70.7159.1352 
 
Homepage / Email address: 
 
Homepage: http://bitsensing.com/ 
Email:  sales@bitsensing.com  



Information to user 

• Any changes or modifications not expressly approved by the party responsible for compliance could

void the user's authority to operate the equipment.

• This equipment has been tested and found to comply with the limits for a Class B digital device,

pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection

against harmful interference in a residential installation. This equipment generates, uses and can

radiate radio frequency energy and, if not installed and used in accordance with the instructions, may

cause harmful interference to radio communications. However, there is no guarantee that interference

will not occur in a particular installation. If this equipment does cause harmful interference to radio or

television reception, which can be determined by turning the equipment off and on, the user is

encouraged to try to correct the interference by one or more of the following measures:

—Reorient or relocate the receiving antenna. 

—Increase the separation between the equipment and receiver. 

—Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 

—Consult the dealer or an experienced radio/TV technician for help. 

Declaration of Conformity in English 

This device complies with Industry Canada licence-exempt RSS standard(s). 
Operation is subject to the following two conditions: 
(1) this device may not cause interference, and (2) this device must accept any interference, 
including interference that may cause undesired operation of the device. 

IC Radiation Exposure Statement: 

This equipment complies with IC RSS-102 radiation exposure limits set forth for an 
uncontrolled environment. This equipment should be installed and operated with the 
minimum distance 20cm between the radiator & your body. 

Déclaration de conformité en francais 

Le present appareil est conforme aux CNR d’Industrie Canada applicables aus appareils radio 
exempts de licence. Léxploitation est autorisée aux deux conditions suivantes: (1) l’appareil 
ne doit pas produire de brouillage, et (2) l’utilisaeur de l’appareil doit accepter tout brouillage 
radioélectrique subi, même si le brouillage est susceptible d’en compromettre le 
fonctionnement. 

DÉCLARATION D’EXPOSITION AUX RADIATIONS 

Cet equipement est conforme aux limites d’exposition aux rayonnements IC établies pour un 
environnement non contrôlé. Cetéquipement doit être installé et utilisé avec un minimum de 
20cm de distance entre la source de rayonnement et votre corps. 




